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うな不利な要因を総称して「システム故障」といいます )。システム故障が財産または人体に危害を及ぼす可能性（身体の損傷
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する場合は、ユーザまたはアプリケーション設計者が、最終的にNI製品の適合性 (かかるシステムまたはアプリケーションの適
切な設計、処理、安全レベルが含まれますが、これに限定されません。）の検証および確認における責任を負うものとします。



本書で使用する表記規則

本コースマニュアルでは、次の表記規則を使用します。

→ →記号に沿って、入れ子のメニュー項目やダイアログボックスをたどって

いくと、最終的に必要な操作を実行することができます。ファイル→ペー

ジ設定→オプションという順になっている場合、まずファイルメニューを

プルダウンし、次にページ設定項目を選択して、最後のダイアログボック

スからオプションを選択します。

このアイコンは、ユーザへのアドバイスを表しています。

このアイコンは、注意すべき重要な情報を表しています。 

太字 太字のテキストは、メニュー項目やダイアログボックスなど、ソフトウェ

アでユーザが選択（クリック）する必要のある項目を表します。また、フ

ロントパネル上のパラメータ名、制御器やボタン、ダイアログボックスま

たはその一部、メニュー名、パレット名も表します。

下線 下線つきのテキストは、重要な事項を示します。

斜体 斜体のテキストは、変数または特定の製品名に使用されます。

Courier New このフォントのテキストは、キーボードから入力する必要のあるテキスト

や文字、 コードの一部、プログラムサンプル、構文例を表します。また、
ディスクドライブ名、パス名、ディレクトリ名、プログラム名、サブプロ

グラム名、サブルーチン名、デバイス名、関数名、演算名、変数名、ファ

イル名と拡張子、引用するコードにも使います。ただし、日本語の文字の

入力や表示は、前後の文と区別するため、「」で囲んでいる場合もありま

す。
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1
システム要件およびインストール

この章では、IMAQ Vision Builderのシステム要件、インストール手順、
および動作環境について説明します。

システム要件

IMAQ Vision Builderを実行するには、以下の最低限のシステム要件を満
たすことが必要です。

• 133 MHz Pentium以上のマイクロプロセッサ（233 MHz Pentium 
MMX以上のマイクロプロセッサ推奨）を使用しているコンピュー
タ。

• Microsoft Windows 2000/NT/Me/9x。Windows NT 4.0をご使用の
場合は、サービスパック 3以降がコンピュータにインストールされ
ていることが必要です。

• 解像度が 800 × 600以上、65,536色（16ビット）以上のビデオア
ダプタ。

• Windows 2000/NT/Me/9x対応ナショナルインスツルメンツ画像集
録（IMAQ）ハードウェアおよび NI-IMAQ 2.5以上（画像集録を行
う場合）。

• RAM：32 MB以上（64 MB推奨）。

• ハードディスクの空き領域：40 MB以上。

メモ 2番目のチュートリアルにある手順を完了するには、Microsoft Excel 97以降が
コンピュータにインストールしてあることが必要です。
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IMAQ Vision Builderをインストールする

メモ IMAQ Vision BuilderをWindows NTまたはWindows 2000で動作しているコン
ピュータにインストールするには、管理者としてログインすることが必要です。

1. IMAQ Vision Builder CDをCD-ROMドライブに挿入します。

CD画面が表示されないときは、Windowsエクスプローラを使用し
て、CDの \Setupディレクトリの中の SETUP.EXEを実行してくだ

さい。

2. 画面に表示されるセットアップの手順に従ってください。

IMAQ Vision Builderのインストールプログラムは、デフォルト設定で
\Program Files\National Instruments\IMAQ Vision Builder 6

という新しいフォルダを作成します。このフォルダには、以下の項目が含

まれています。

• プログラムフォルダ：IMAQ Vision Builder.exe、オンラインヘル

プファイル、関数ライブラリ、その他の関連プログラムファイル。

• readme.txt：IMAQ Vision Builderについての最新情報。

• exampleフォルダ：このマニュアルにあるサンプルのチュートリア

ルを完了するのに必要な画像およびスクリプト。

• manualsフォルダ：『IMAQ Vision Concepts Manual』、『IMAQ 
Vision Builderリリースノート』、およびこのマニュアルの PDFファ
イル。これらのドキュメントを参照するには、Adobe Acrobat 
Readerをインストールしてあることが必要です。

• solutionsフォルダ：サンプル画像およびスクリプト。

IMAQ Vision Builderの起動と終了
IMAQ Vision BuilderをWindowsで起動するには、スタート→プログラ
ム→ National Instruments→ IMAQ Vision Builder 6を選択します。

IMAQ Vision Builderを終了するには、次の手順に従ってください。

1. 開いているパラメータウィンドウをすべて閉じます。

2. スクリプトおよび画像を保存します。

3. File→ Exitを選択します。
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IMAQ Vision Builderの環境
IMAQ Vision Builderは、画像処理アプリケーションをプロトタイプし、
テストするツールです。画像処理アプリケーションをプロトタイプするに

は、IMAQ Vision Builderのスクリプト作成機能を使用してカスタムアル
ゴリズムを作成します。スクリプト作成機能は、処理するアルゴリズムの

手順をすべて記録します。動作するかどうかを確認するには、アルゴリズ

ムの完成後、他の画像でテストすることができます。

アルゴリズムは、Builderファイルに記録されています。Builderファイ
ルは、IMAQ Vision Builderでプロトタイプするアルゴリズム用の処理関
数および関連パラメータのリストを記載した ASCII形式のテキストファ
イルです。LabVIEW VI生成ウィザードを使用して、IMAQ Vision 
Builderで作成したプロトタイプを実行する LabVIEW VIを作成すること
ができます。

メモ この機能を使用するには、LabVIEW 6.0以降および LabVIEW対応 IMAQ 
Vision 6以降がコンピュータにインストールしてあることが必要です。

LabVIEW VIの作成に関する詳細については、第 3章「粒子解析を使用し
た金属構造解析」の「LabVIEW VIを作成する」を参照してください。

IMAQマシンビジョンおよび画像処理ライブラリを使用して、Builder
ファイルにより定義されたアルゴリズムを LabWindows/CVIまたは
Visual Basic等のどのような開発環境にでも採用することができます。

特徴
IMAQ Vision Builderには、以下のような特徴があります。

• スクリプトウィンドウ：一連の画像処理工程と各工程で使用する設定

を記録します。スクリプトは、1つの画像で、または、画像をまとめ
て（バッチ処理）実行することができます。スクリプトは、修正、保

存ができます。スクリプトをスクリプトウィンドウで表示するには、

図 2-4「2値化画像」を参照してください。

• 画像ブラウザ：現在 IMAQ Vision Builderにロードされている画像
がすべて含まれています。画像ブラウザにより、処理する画像をダブ

ルクリックして選択することができます。画像ブラウザにロードされ

た画像を表示するには、図 2-1「画像ブラウザ」を参照してくださ
い。

• 集録ウィンドウ：デバイスウィンドウ（使用可能な IMAQ画像集録
ボードおよびチャネル）および IMAQ画像集録ボードのプロパティ
ページを表示します。集録ウィンドウの要素をすべて表示するには、

図 2-5「IMAQ Vision Builderで画像を集録」を参照してください。
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• 処理ウィンドウ：パラメータを変更すると、画像をアップデートしま

す。この表示はパラメータウィンドウでの変更を直ちに反映するた

め、最適な結果が得られるまでパラメータを変更することができま

す。処理ウィンドウにロードされた画像を表示するには、図 2-2「画
像処理」を参照してください。

• パラメータウィンドウ：画像処理関数のために設定できるパラメータ

を表示します。メニューから使用可能な各 IMAQ Vision関数には、
各パラメータを設定できるパラメータウィンドウが 1つあります。
2値化パラメータウィンドウのサンプルを表示するには、図 2-3「画
像の 2値化」を参照してください。

• リファレンスウィンドウ：画像を処理ウィンドウで操作する際、オリ

ジナルの画像（元の画像）を表示します。リファレンスウィンドウの

画像を表示するには、図 2-2「画像処理」を参照してください。

• ツールパレット：関心領域（ROI）を選択するツールを集めたもので
す。ズームイン、ズームアウト、画像パレットの変更も可能です。

ツールパレットを表示するには、図 2-4「2値化画像」を参照してく
ださい。

• ソリューションウィザード：産業別品質保証タスクのリストを表示し

ます。ユーザが選択するタスクを基に、ウィザードは IMAQ Vision
ベースのソリューションをロードします。

• パフォーマンスメータ：IMAQ Visionを使用して画像を処理した場
合のスクリプトの所要時間を予測します。

• LabVIEW VI 自動生成：IMAQ Vision Builderで構築したプロトタイ
プアルゴリズムに相当する LabVIEWならびに IMAQ Vision VIを作
成します。選択したオプションに基づいて、LabVIEW VI生成ウィ
ザードは、現在のスクリプトまたは保存したスクリプトファイルの画

像処理工程を取り入れた新しい VIを作成します。

画像解析関数
IMAQ Vision Builderには、以下のような画像解析関数があります。

• ヒストグラム（Histogram）：各グレースケール値のピクセルの総数
をカウントし、それをグラフ化します。

• ラインプロファイル（Line Profile）：ツールパレットのラインツール
で引いたライン上にあるピクセルのグレースケール値を返し、それを

グラフ化します。

• 3D表示（3D View）：等角図法で画像を表示します。元の画像の各ピ
クセルは、3D表示のピクセルコラムで列として表示されます。ピク
セルの値は、その高さに対応しています。
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カラー画像処理関数
IMAQ Vision Builderには、以下のようなカラー画像処理および解析用総
合関数セットがあります。

• カラー演算子（Color Operators）：2つの画像間あるいは画像と定
数間で演算操作を適用します。

• カラープレーン抽出（Color Plane Extraction）：赤、緑、青のプ
レーンまたはカラー画像の色相、彩度、輝度を抽出します。

• カラー 2値化（Color Threshold）：2値化を RGBや HSL画像の 3
平面に適用します。

• カラー位置（Color Location）：画像内の色を見つけます。

• カラーマッチング（Color Matching）：1つまたは複数の画像領域
のカラーの内容を基準カラーセットと比較します。

• カラーパターンマッチング（Color Pattern Matching）：画像内の
カラーテンプレートを検索します。

グレースケール画像処理と解析関数
IMAQ Vision Builderには、グレースケール画像処理および解析のための
関数があります。

• フィルタ処理（Filtering）：平滑化、エッジ検出、重畳積分のための
関数。

• ルックアップテーブル（Lookup Tables）：以前に定義された照合表
変換を画像に適用し、コントラストが低い画像内領域のダイナミック

輝度を修正します。

• 演算子（Operators）：画像の基本的な算術演算および論理演算を行
います。

• グレースケールモフォロジー処理（Grayscale Morphology）：縮小
関数、膨張関数、オープン関数、クローズ関数で、グレースケール画

像のオブジェクトの形を修正します。

• 2値化（Threshold）：処理するピクセルを分離し、残りのピクセル
を背景のピクセルとして設定します。

• 量子化（Quantify）：1つまたは複数の画像領域の輝度統計を測定し
ます。

• 図心（Centroid）：グレースケール画像または関心領域のエネルギー
の中心を計算します。
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2値化処理と解析関数
IMAQ Vision Builderには、2値化処理と解析のための関数があります。

• バイナリモフォロジー処理（Binary Morphology）：2値化画像のオ
ブジェクトの形を修正する形態変形を行います。

• 逆 2値化（Invert Binary Image）：異なる 2つのグレースケール集
合のある画像の原動力を逆にします。

• 粒子フィルタ処理（Particle Filtering）：形状の測定に基づいて、オ
ブジェクトをフィルタ処理します。

• 粒子解析（Particle Analysis）：画像 1つのオブジェクトに対し、40
を超える測定値を計算します。

• 円形検出（Circle Detection）：半径をもとに、重なっている円形の
オブジェクトを離して分類します。

マシンビジョン関数
IMAQ Vision Builderの特徴として、以下のようなマシンビジョン関数が
あります。

• エッジ検出（Edge Detection）：ツールパレットのラインツール で
引いたライン上にあるエッジを見つけます。

• 直線エッジ検出（Find Straight Edge）：オブジェクトのエッジの点
を見つけ、エッジを結ぶ線を検出します。

• 円形エッジ検出（Find Circular Edge）：円形領域（環状部）内の検
索ライン間の交点を見つけ、最適の円を検出します。

• クランプ（Clamp）：画像の四角形の関心領域内のエッジを探し、最
初のエッジと最後のエッジとの距離を計測します。

• パターンマッチング（Pattern Matching）：標準テンプレートに合
うグレースケール画像の領域を見つけます。パターンマッチングによ

り、不良照明、不鮮明性、ノイズ、テンプレートの横ずれ、テンプ

レートの回転に関わらず、一致するテンプレートを見つけ出すことが

できます。

• キャリパ（Caliper）：他のマシンビジョン関数および画像処理関数が
返す結果に基づいて、距離、領域、角度などの測定値を計算します。
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キャリブレーション関数
IMAQ Vision Builderには、以下のようなキャリブレーション関数があり
ます。

• 簡易キャリブレーション（Simple Calibration）：画像用に簡易キャ
リブレーションを設定します。この関数は、縦軸と横軸の計数比を設

定します。また、画像のための座標の原点と方位も設定します。

• グリッドキャリブレーション（Grid Calibration）：キャリブレー
ションを行っている画像の設定で集録したグリッドテンプレートの画

像に基づいて、キャリブレーションを習得します。

• 画像ベースキャリブレーション（Calibration from Image）：画像
ファイルに保存したキャリブレーション情報を現在の画像に適用しま

す。

• 画像補正（Image Correction）：キャリブレーションされた設定で
集録した歪んだ画像を、予想されるエラーとレンズの歪みを矯正した

画像に変形します。

へルプ

IMAQ Vision Builderの使用に関する質問については、その他の資料もご
利用ください。IMAQ Vision、IMAQハードウェア、イメージングの詳
細については、以下の資料を参照してください。

IMAQ Vision Builder オンラインヘルプ
IMAQ Vision Builderにはオンラインヘルプやツール使用上のヒントがあ
り、以下の方法でアクセスできます。

• IMAQ Vision Builderのオンラインヘルプにアクセスするには、
Helpメニューの「Online Help」を選択します。画像処理関数を実
行するための関数の説明やガイドなど、このマニュアルにはない情報

をご覧いただけます。

• カーソルをボタン上に移動すると、操作ツールバー、ツールパレッ

ト、スクリプトウィンドウ、リファレンスウィンドウ、集録ウィンド

ウ、画像ブラウザにある各ボタンの使用上のヒントを参照することが

できます。

• 関数パラメータウィンドウの Helpボタンをクリックすると、関数と
そのパラメータに関する情報を参照することができます。
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IMAQ Visionに付属の資料
ナショナルインスツルメンツの IMAQ Visionソフトウェアをご購入時に
は、以下の資料が一式同梱されています（ご使用の開発環境により異なり

ます）。 

• LabVIEW対応 IMAQ Vision

– 『IMAQ Vision for LabVIEW User Manual』：LabVIEW対応
IMAQ Visionを使用して、ビジョンアプリケーションを作成す
る方法が記載されています。

– LabVIEW対応 IMAQ VisionのOnline Help（LabVIEW環境
内：ヘルプ→ IMAQ Vision）：IMAQ Vision VIのリファレンス
情報が記載されています。

• Measurement Studio対応 IMAQ Vision

– 『Measurement Studio for IMAQ Vision User Manual』：
LabWindows/CVI：LabWindows/CVI対応 IMAQ Visionを
使用してビジョンアプリケーションを作成する方法が記載されて

います。

– LabWindows/CVI用 IMAQ Vision Online Help：
LabWindows/CVI対応 IMAQ Visionのリファレンス情報が記
載されています。

– 『Measurement Studio for IMAQ Vision User Manual：Visual 
Basic』：Measurement Studio対応 IMAQ Visionに同梱され
ている Visual Basic用のツールを使用して、ビジョンアプリ
ケーションを作成する方法が記載されています。

– Visual Basic用 IMAQ Visionオンラインヘルプ：
Measurement Studio用 IMAQ Visionに同梱されている
Visual Basic用のツールに関するリファレンス情報が記載され
ています。

IMAQ Vision Builderにおける概念とアルゴリズムの詳細については、
『IMAQ Vision Concepts Manual』をスタートメニュー（スタート→プ
ログラム→ National Instruments→ IMAQ Vision Builder 6→ IMAQ 
Vision Concepts Manuaｌ）から起動して参照してください。
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ナショナルインスツルメンツのWebサイト
ナショナルインスツルメンツのWebサイトでは、IMAQハードウェア
およびソフトウェアについて記載されています。ni.com/jp/imaqをご

覧ください。

IMAQのWebサイトでは、IMAQビジョンの特徴、マシンビジョンの
問題点とソリューション、マシンビジョンアプリケーションにおける

MMX技術の活用法、ご使用のアプリケーションに適切な IMAQハード
ウェア、カメラ、レンズ、照明機器に関する情報をご覧いただけます。

NI Developer Zone（ni.com/zone）は、計測およびオートメーション

システムを作成する時の大変重要な資料です。NI Developer Zoneでは、
最新のサンプルプログラム、システム構成機器、チュートリアル、技術情

報、また独自のテクニックを習得できる開発者のコミュニティをご利用に

なれます。

IMAQ Vision Builderのスクリプト
IMAQ Vision Builderをインストールすると、サンプルスクリプトがイン
ストールされます。こうしたスクリプトを実行し、IMAQ Vision Builder
のスクリプト作成機能について、さらに学ぶことができます。また、独自

のアプリケーションとして、サンプルスクリプトをカスタマイズもするこ

ともできます。デフォルトでは、スクリプトは \Program 

Files\National Instruments\IMAQ Vision Builder 6\Examples

および \Program Files\National Instruments\IMAQ Vision 

Builder 6\Solutionsにインストールされています。
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2
IMAQ Vision Builder
画像処理入門

この章には、ユーザ独自の画像処理アルゴリズムを作成、テストする際の

IMAQ Vision Builderの使用方法が記載されています。まず、IMAQ 
Vision Builderの何から取りかかればよいかを説明します。デジタル画像
の詳細については、『IMAQ Vision Concepts Manual』の第 1章
「Digital Images」を参照してください。

IMAQ Vision Builder入門
このセクションでは、このマニュアルのチュートリアルを終了、また

Online Helpを理解する上で必要なソフトウェアの専門用語について説
明します。IMAQ Vision Builderがどのように動作するか、また IMAQ 
Vision Builderで何を実行できるかを理解するのに最も良い方法は、実際
にそれを使用することです。

このサンプルでは、IMAQ Vision Builderに画像をロードし、画像処理関
数（2値化）を 1つ実行します。2値化によりオブジェクト同士が分離す
るため、必要なオブジェクトをそのまま保有し、不要なオブジェクトを削

除することができます。また、2値化では、画像をピクセル値 0～ 255
の範囲のグレースケール画像から、ピクセル値 0または 1のバイナリ画
像に変換します。

以下の手順に従い、IMAQ Vision Builderを開始してください。

1. IMAQ Vision Builderをスタートメニュー（スタート→プログラム→
National Instruments IMAQ Vision Builder 6）から起動します。 

2. 画像をロードするには、Welcomeの画面からOpen Imageボタ
ンを選択します。

3. Program Files\National Instruments\IMAQ Vision Builder 

6\Examples\Metalを開き、Select All Filesをチェックします。
IMAQ Vision Builderでは、Preview Imageウィンドウで画像をプ
レビューし、ファイルの種類と画像の深度について表示します。

4. OKをクリックします。
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図 2-1のように、IMAQ Vision Builderは選択された画像ファイルを
画像ブラウザにロードします。画像ブラウザから、画像のサイズ、保

存場所、タイプなど、選択した画像情報を得ることができます。

図 2-1 画像ブラウザ

新しい画像を最小化（図 2-1参照）または最大化（選択された画像 1
つを最大で表示）表示することができます。

5. 最小化／最大化トグルボタンをクリックし、最初の画像を最大化表示

します。

1 画像ブラウザ
2 画像の保存場所

3 ブラウズボタン

4 最小化 /最大化トグル
5 画像サイズ

6 選択された画像を閉じる

7 画像タイプ
8 ファイルフォーマット

4

1

2

3

6 7 85
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6. 処理モードを変更するために、画像 Metal1.jpgをダブルクリック

します。図 2-2のように、IMAQ Vision Builderは選択した画像を処
理ウィンドウにロードします。

図 2-2 画像処理

ヒント リファレンスウィンドウは、画像を処理ウィンドウで操作する際、オリジナル

の画像を表示します。

1 リファレンスウィンドウ

2 スクリプトウィンドウ
3 画像サイズ

4 ズーム比
5 処理ウィンドウ

1 5

2 3 4
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7. Grayscale→ Thresholdを選択します。図 2-3のように、2値化パ
ラメータウィンドウが IMAQ Vision Builderウィンドウの右下端に
表示されます。

図 2-3 画像の 2値化

2値化パラメータウィンドウはヒストグラムを表示します。ヒストグ
ラムは、各グレースケール値のピクセルの総数をカウントし、それを

グラフ化します。特定のグレースケール値の領域が画像にあるかどう

かをグラフから読み取ることができ、画像のピクセル領域を選択する

ことができます。例えば、画像の背景が黒で、それを削除したい場合

は、255（白）に近い範囲を選択します。

1 ツールパレット 2 2値化パラメータウィンドウ

2

1
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パラメータウィンドウには、現在のパラメータ値を使用した 2値化
操作のプレビューが表示されます。赤で描かれたピクセルの輝度は、

2値化の範囲内となります。2値化演算子により、その値は 1に設定
されます。灰色で描かれたピクセルの値は、しきい値範囲外です。そ

うした値は 2値化演算子により、0に設定されます。

8. 2値化パラメータウィンドウから、アプリケーションに最適の設定を
指定します。この画像を 2値化するには、Min 値を 130に、Max値
を 255に設定してオブジェクトをすべて選択します。

ヒント 最適な値を見つけるには、パラメータを何回か操作することが必要かもしれま

せん。MinやMaxのフィールドに数値を入力する代わりに、ヒストグラムのポ
インタを使用して範囲を選択することもできます。ポインタを調節して、選択

するオブジェクトを赤でハイライトします。黒いポインタは最小値を、白いポ

インタは最大値を示します。

9. OKをクリックして、手動によるしきい値を画像に適用します。画像
が、バイナリ画像に変換されます。ここで、しきい値範囲内の選択し

たピクセルはすべて 1（赤）に設定され、その他のピクセルはすべて
0（黒）に設定されます。
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2値化を適用すると画像がどのようになるかを確認するには、図 2-4
を参照してください。

図 2-4 2値化画像

この 2値化の手順はスクリプトウィンドウに記録されています。ス
クリプトは処理操作およびそのパラメータをすべて記録します。同じ

操作を他の画像で実行する必要がある場合は、スクリプトを保存して

また使用することができます。

1 スクリプトツール 2 スクリプトウィンドウ

1 2
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10. Script→ Save Scriptを選択し、スクリプトの名前を
threshold.scrとします。

同様に、2値化する必要のある別の画像を見つけるには、次の手順で
画像のスクリプトを実行します。

a. 画像をロードします。

b. Script→Open Scriptを選択し、threshold.scrを開きます。

c. スクリプトのウィンドウの Run Scriptボタンをクリックします。
別のオプション、画像で試してみます。例えば、この画像内の各オブ

ジェクトが占有する領域を見つけるには、粒子解析を実行します。パ

ラメータウィンドウの Helpは、特定の画像処理操作に関する問題解
決に役立ちます。

11. File→ Exitを選択し、IMAQ Vision Builderを閉じます。

IMAQ Vision Builderの画像を集録する
IMAQ Vision Builderには、スナップ、グラブ、シーケンスの 3つのタイ
プの画像集録方法があります。スナップは、画像を 1枚集録し、表示し
ます。グラブは、連続するシーケンスを集録して表示します。これは、例

えばカメラをフォーカスするときに役立ちます。シーケンスは、指定した

設定により画像を複数枚集録し、画像を画像ブラウザに送ります。

ナショナルインスツルメンツの IMAQ画像集録ボードおよび
NI-IMAQ 2.5以降がインストールされている場合、IMAQ Vision 
Builderのライブ画像を集録することができます。Measurement & 
Automationエクスプローラ（MAX）内のボードとチャネルの設定の詳
細については、MAXのオンラインヘルプを参照してください。

IMAQ画像集録ボードおよび NI-IMAQ 2.5以降がインストールされてい
ない場合、IMAQ Vision Builderは画像シーケンスを表示して集録プロセ
スを自動的にシミュレーションします。フレームのシーケンスを停止し、

画像をキャプチャして、その画像を画像処理用の画像ブラウザに転送する

ことができます。
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集録ウィンドウを開く
IMAQ Vision Builderがロードされない場合、スタートメニュー（スター
ト→プログラム→ National Instruments IMAQ Vision Builder 6）から
アプリケーションを起動します。集録ウィンドウを表示するには、図 2-5
のようにして、Welcomeスクリーンの Acquire Imageボタンをク
リックします。

IMAQ Vision Builderを既に実行している場合は、ツールバーの
Acquire Imageボタンをクリックします。IMAQ Vision Builderは、
図 2-5のように、集録ウィンドウを表示します。

集録プラグインリストには、画像集録に使用できる複数のモジュールがあ

ります。

• シミュレーションモジュール

• 画像集録ボード

デバイスウィンドウは、ご使用のシステムで使用可能な IMAQ画像集録
ボードおよびチャネルをすべて表示します。図 2-5は、IMAQ PCI-1408
および IMAQ PCI-1424の 2つの IMAQハードウェアが使用できること
を示しています。

メモ デバイスウィンドウに表示されるハードウェアボードの種類は、システムでご

使用のボードにより異なります。
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図 2-5 IMAQ Vision Builderで画像を集録

デバイスウィンドウの上のプロパティページには、選択したボードで使用

可能なプロパティが記載されています。図 2-5では、IMAQ PCI-1408が
選択されています。PCI-1408は画像シーケンスの集録が可能であるた
め、シーケンス集録のために次のプロパティを設定することができます。

他の IMAQボードのプロパティの詳細については、ハードウェアマニュ
アル、MAXのオンラインヘルプを参照してください。

• フレーム数：集録するフレームの数

• スキップカウント：集録間で除外したいフレーム数

• ライン：実際のトリガライン

1 集録ウィンドウ

2 集録プロパティぺージ
3 集録された画像を画像ブラウザに格納する

4 IMAQ画像集録ボードおよびチャネル

1

2

3

4
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• アクション：トリガアクション 

– 無効：トリガを無効にします。

– 集録開始をトリガ

– 各画像をトリガ

• タイムアウト：トリガが発生する時間間隔（ミリ秒）

メモ トリガは、何らかの形式のデータのキャプチャを発生または開始させる信号で

す。

画像集録ボードまたはカメラの別のプロパティを設定するには、ボードま

たはチャネルをリストから選択し、MAXボタンをクリックして対応する
MAXプロパティウィンドウを表示します。 

MAXプロパティウィンドウの詳細は、MAXのオンラインヘルプを参照
してください。

メモ IMAQ Vision Builderでライブ画像を集録するには、ナショナルインスツルメン
ツの IMAQ画像集録ボードおよび NI-IMAQ 2.5以降がインストールされている
ことが必要です。

画像をスナップする（1回の集録）
1. 集録ウィンドウが開いていることを確認してください。

2. IMAQボードで画像を 1枚集録、表示するには、Acquire Single 
Imageボタンをクリックします。この操作のことをスナップといい
ます。

メモ IMAQボードをシステムに取りつけていない場合、IMAQ Vision Builderはラ
イブ集録プロセスをシミュレーションします。シミュレーションモジュールで

の対話方式は、ライブ集録モジュールの対話方式と同様です。

3. 画像を画像ブラウザに転送するには、Store Acquired Image in 
Browserボタンをクリックします。

4. 画像ブラウザに戻るには、Returnをクリックします。

5. IMAQ Vision Builderの他の画像と同様に、画像を処理します。
IMAQ Vision Builderでの画像処理の例については、第 3章「粒子解
析を使用した金属構造解析」および第 4章「ゲージングを使用した
部品検査」を参照してください。
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画像をグラブする（連続集録）
1. 集録ウィンドウが開いていることを確認してください。

2. 画像を最高レートで連続モード集録し、表示するには、Acquire 
Continuous Imagesボタンをクリックします。この操作は、グラ
ブといいます。

3. 最後に集録した画像の集録、表示を停止するには、Acquire 
Continuous Imagesボタンをもう一度クリックします。

ヒント 最大化画像内の関心領域を選択して、その部分のみを集録することができます。

グラブを実行しながら画像の関心領域を選択すると、画像はその領域の大きさ

に縮小します。他の関心領域を選択すると、その集録領域を改良することがで

きます。また、画像をクリックすると、最大化の画像に戻ります。

4. 画像を画像ブラウザに転送するには、Store Acquired Image in 
Browserボタンをクリックします。

5. 画像ブラウザに戻るには、Returnをクリックします。

6. IMAQ Vision Builderの他の画像と同様に、画像を処理してくださ
い。IMAQ Vision Builderの画像処理の例については、第 3章「粒子
解析を使用した金属構造解析」および第 4章「ゲージングを使用し
た部品検査」を参照してください。

画像のシーケンスを集録する
1. 集録ウィンドウが開いていることを確認してください。

2. Sequenceプロパティページのプロパティを設定してください。

3. Sequence Acquisitionボタンをクリックして、ライブ画像のシー
ケンスを集録します。シーケンス集録の状態を説明するパネルが表示

されます。

Triggering action propertyを Disabledに設定し、Start 
Acquisitionボタンをクリックして画像シーケンスの集録を開始しま
す。

集録された画像は、画像ブラウザに自動的に転送されます。

メモ IMAQボードをシステムに取りつけていない場合、IMAQ Vision Builderはラ
イブ集録プロセスをシミュレーションします。シミュレーションモジュールで

の対話方式は、ライブ集録モジュールの対話方式と同様です。

4. 画像ブラウザに戻るには、Returnをクリックします。

5. IMAQ Vision Builderの他の画像と同様に、画像を処理します。
IMAQ Vision Builderの画像処理の例については、第 3章「粒子解析
を使用した金属構造解析」および第 4章「ゲージングを使用した部
品検査」を参照してください。
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3
粒子解析を使用した金属構造解析

この章には、粒子解析についての説明と、IMAQ Vision Builderの粒子解析
アプリケーションをプロトタイプするための各手順が記載されています。

粒子解析とは？

粒子解析は、一連の処理操作および画像の粒子に関する情報を生成する解

析関数から成り立っています。粒子（＝大きなバイナリオブジェクト）

は、画像内における同じ輝度レベルのピクセルの結合した領域やグループ

として定義されます。バイナリ画像では、背景のピクセルの値はゼロ、値

がゼロ以外のピクセルはバイナリオブジェクトの一部です。

統計的情報（粒子の大きさ、数、位置、粒子領域の有無等）を取得するに

は、粒子解析を実行してください。形や向きに有意差がある場合、この情

報を基にシリコンウエハのキズや PCBのはんだの欠陥等を検出したり、
モーションアプリケーションにおいてオブジェクトを判別したりすること

ができます。

チュートリアル

このチュートリアルでは、金属の円形粒子の面積を求めます。この解析を

実行する際、IMAQ Vision Builderは処理操作およびスクリプトのパラ
メータをすべて記録するので、そのスクリプトを他の画像で実行し、粒子

解析のアルゴリズムをテストすることができます。

円形粒子の全面積を求めるには、画像処理を以下の手順で実行してくださ

い。

• 画像にフィルタ処理を施してエッジを鮮鋭にし、背景から粒子を分離

しやすくします。

• 画像を 2値化し、情報を得ようとしているピクセル（粒子）を分離
します。

• 2値化によって粒子に表れた穴を埋めます。

• 不完全な粒子を削除するため、画像の縁に接触しているオブジェクト

をすべて取り除きます。
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• 粒子フィルタを使用して円形粒子をすべて見つけ、非円形粒子を取り

除きます。

• 粒子解析を行い、円形粒子が占める総面積を出します。

画像を IMAQ Vision Builderにロードする
1. IMAQ Vision Builderがロードされていない場合、スタートメニュー
（スタート→プログラム→ National Instruments IMAQ Vision 
Builder 6）からアプリケーションを起動してください。Welcome
画面でOpen Imageボタンをクリックします。

IMAQ Vision Builderを既に実行している場合は、ツールバーの
Open Imageボタンをクリックします。

2. Program Files\National Instruments\IMAQ Vision Builder 

6\Examples\Metalを開き、Select All Filesオプションにチェック
マークを付けます。IMAQ Vision Builderでは、画像プレビューウィ
ンドウで画像が表示され、ファイルの種類、画像サイズ、および画像

深度が表示されます。

ヒント 画像プレビューウィンドウには、選択した画像がすべて順に表示されます。画

像を表示する速さを変更するには、画像プレビューウィンドウの右にある速度

スライドを調節します。

3. OKをクリックします。

IMAQ Vision Builderは、顕微鏡を使用して集録した金属片の画像
ファイルを画像ブラウザにロードします。処理したい画像をブラウザ

内の画像から選択することができます。

4. 最初の画像、Metal1.jpgをダブルクリックします。画像が処理ウィ

ンドウにロードされます。

粒子解析用に画像を整える
円形粒子を非円形粒子から分離する前に、画像を整える必要があります。

情報を得ようとする粒子を分離するには、個々の粒子が他の粒子から離れ

ている（粒子ギャップがある）こと、またそうした粒子の境界がはっきり

としていることを確認します。

画像について検討する
処理ウィンドウで画像をよく見てください。画像がわずかにぼやけていま

す。また、粒子のエッジがはっきりしていません。こうした問題点は画像

をちょっと見ただけでわかりますが、ラインプロファイルを使用すること

が必要な場合もあります。ラインプロファイルは、ツールパレットのライ

ンツールで引いたライン上にあるピクセルのグレースケール値を返しま

す。以下の手順に従い、エッジをラインプロファイルで検査します。
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1. Image→ Line Profileを選択します。パラメータウィンドウが表れ、
ツールパレットにあるラインツールが自動的に選択されて有効になり

ます。

2. 図 3-1のように、粒子の真中を通る短いラインを引きます。

ヒント ROI（関心領域）は、文脈依存で、画像内の関心領域の場所や中心点の位置を簡
単に調節することができます。また、画像内の ROIの場所を矢印キーで調節す
ることもできます。

図 3-1 ラインプロファイルを使用してエッジを確認する

1 粒子のエッジ

2 ピクセル値の変動
3 ラインツールで引いた線分

1 2 3



第 3章 粒子解析を使用した金属構造解析

IMAQ Vision Builderチュートリアル 3-4 ni.com/jp

図 3-1の 1は、粒子のエッジを表します。両方の粒子のエッジには傾
斜があることに注目してください。エッジの正確な場所を検出する際

のばらつきは、傾斜が緩やかなほど大きくなります。粒子エッジの傾

斜が緩やかな画像のしきい値のレベルを変更する際、粒子の形や大き

さを間違えて変えてしまうおそれがあります。「画像をフィルタ処理

する」のセクションでは、粒子のエッジを定義し、傾斜をはっきり出

すため、Grayscale→ Filtersにある Convolution-Highlight 
Detailsフィルタを使用します。

2の領域は、ピクセル値の変動を示します。これは、粒子の中心にあ
るピクセルがより明るかったり暗かったりする場合や、粒子内に穴が

ある場合に起こります。後ほど、画像を 2値化して、粒子のピクセ
ルをすべて同じピクセル値にし、粒子内に残っている穴をすべて埋め

るため、その画像に対してモフォロジー処理を行います。

3. Closeをクリックします。

画像をフィルタ処理する
フィルタを使用すると、平滑化、鮮鋭化、変形、およびノイズ除去ができ

るため、必要な情報を得ることができます。エッジ（粒子内の穴を含む）

に鮮鋭化処理を施し、粒子と背景間にコントラストを持たせるには、次の

手順に従ってください。

1. Grayscale→ Filtersを選択します

2. フィルタリストから Convolution-Highlight Detailsを選択します。
この関数は、ギャップをよりはっきりさせるために、鮮鋭な遷移を探

し、カーネルに従って、エッジのピクセルをハイライトします。カー

ネルは、ピクセルおよびそのまわりのピクセルとの関係を表す構造体

です。カーネルの詳細については、『IMAQ Vision Concepts 
Manual』（英語）の第 5章「Images Processing」を参照してくだ
さい。

3. Applyをクリックして、この手順をスクリプトに追加します。

4. Closeをクリックします。

フィルタ処理後の画像について検討する
フィルタによりエッジが鮮鋭になったかどうか、また粒子が離されたかど

うか確認するには、もう一度ラインプロファイルを次の手順で行ってくだ

さい。

1. Image→ Line Profileを選択します。

2. 図 3-2のように、粒子とその境界のラインプロファイルを検討するた
め、クリックしドラッグして粒子の真中を通る短い線分を引きます。

ラインプロファイルはより鮮明なエッジを示します。

3. Closeをクリックします。
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図 3-2 ラインプロファイルを使用して粒子のエッジを確認する

2値化により粒子と背景を分離する
2値化により、処理するピクセルが分離され、残りのピクセルは背景のピ
クセルとして設定されます。また、2値化により、グレースケール画像が
バイナリ画像に変換されます。

2値化パラメータウィンドウはヒストグラムを表示します。ヒストグラム
は、各グレースケール値のピクセルの総数をカウントし、それをグラフ化

します。特定のグレースケール値の領域が画像にあるかどうかがグラフか

らわかり、画像のピクセル領域を選択することができます。

解析のためにより明るいピクセル値範囲を選択するには、以下の手順に

従ってください。

1. Grayscale→ Thresholdを選択します

2. Manual Thresholdを 2値化リストから選択します。

3. 130～ 255の範囲を選択します。
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処理対象の粒子（円形および非円形）は赤でハイライトされているこ

とに注意してください。しきい値を適用する際、ハイライトされてい

るピクセルはすべて 1に、その他のピクセルはすべて 0に設定され
ます。

ヒント ポインタを調節し、処理対象の粒子をすべて赤くハイライトします。黒いポイ

ンタは最小値を、白いポインタは最大値を示します。

4. OKをクリックしてしきい値を適用し、この手順をスクリプトに追加
します。図 3-3は、バイナリ画像を示しています。処理するために選
択したピクセルは、赤く表示されます。選択しなかったピクセルは、

黒く表示されます。

この時点で、画像はバイナリ画像になります。これは、0および 1の
値のピクセルで構成されている画像です。この画像は、画像のピクセ

ルの輝度を特有の色で表すバイナリパレットを使用して表示されてい

ます。値が 0のピクセルはすべて黒く表示され、1に設定されたピク
セルは赤く表示されます。この時点で、赤いピクセルは粒子であると

言えます。
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図 3-3 2値化により粒子と背景を分離する

モフォロジー関数で粒子を修正する
モフォロジ―関数は粒子の形に影響します。バイナリ画像の各粒子または

領域は、個々の単位で影響を受けます。モフォロジー処理により、面積、

周囲の長さ、向き等を調べる定量分析用に画像の粒子を整えます。以下の

手順で、2つのモフォロジ―関数を画像に適用してください。最初の関数
は粒子の穴を埋め、2番目の関数は画像の縁に接触しているオブジェクト
を削除します。

1. Binary→ Adv.Morphologyを選択します。

2. Morphology-Advanced functionリストの Fill holesを選択しま
す。

3. Applyをクリックして、この手順をスクリプトに追加します。

4. Remove border objectsを選択し、画像の縁に接触しているオブ
ジェクトをすべて取り除きます。結果は図 3-4のようになります。

5. Applyと Closeをクリックし、この手順をスクリプトに追加し、
Advanced Morphologyウィンドウを閉じます。
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図 3-4 モフォロジー関数で粒子を修正する

円形粒子を分離する
円形粒子を分離して維持し、非円形粒子を画像から取り除く粒子フィルタ

を次の手順で定義します。

1. Binary→ Particle Filterを選択します。

2. 粒子フィルタのリストから Heywood circularity factorを選択しま
す。この関数は、面積が同じ円の円周に対する粒子の周辺の比率を計

算します。粒子が円形に近いほど、1に近い比率となります。

3. 円形により近く楕円形からより遠い粒子を見つけるため、最小値を 0
および最大値を 1.06としてパラメータ範囲に入力します。

4. Keep Objectsオプションを選択し、円形粒子を維持します（また、
この範囲外の粒子を削除します）。

5. OKをクリックして、この手順をスクリプトに追加します。この時点
では、図 3-5のように、画像には円形粒子のみが含まれます。
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図 3-5 円形粒子を分離する

円形粒子を解析する
これで、円形粒子を分離できました。次の手順で、粒子の面積を調べます。

1. Binary→ Particle Analysisを選択します。測定結果をすべて表す結
果表が表示されます。

IMAQ Vision Builderでは、数値ラベルを各粒子に割り当てます。結
果表の最初の行は、各粒子に関する数値ラベルを示します。

2. Show/Hide Labelsボタンをクリックし、ラベルを表示します。

ヒント 粒子上をクリックすると、その粒子の測定結果が青くハイライトされます。粒子

の結果をクリックすると、その粒子は処理画面に緑色枠でハイライトされます。

3. 面積測定のみを表示するには、Choose Measurementsボタンをク
リックします。

4. 測定の選択をすべて解除するには、Noneをクリックします。
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5. Area （unit）をクリックします。

6. OKをクリックします。

7. Applyをクリックして、粒子解析をスクリプトに記録します。

8. Closeをクリックします。

これで、金属構造の解析に必要な情報はすべて取得できました。

LabVIEW、LabWindows/CVI、Visual Basicソリューションとしては
この後計測結果の解析を含めるようにしてください。また、IMAQ Vision 
Builderで生成したデータの解析には、Microsoft Excelも使用すること
ができます。

ヒント データをMicrosoft Excelに送信するには、粒子解析結果ウィンドウの Send 
Data to Excelボタンをクリックします。

粒子解析スクリプトをテストする
この画像を処理する際作成したスクリプトは、カスタムアルゴリズムで

す。このアルゴリズムをテストするには、次の手順に従って、画像集にあ

る別の画像上でスクリプトを実行します。

1. 標準ツールバーの Browse Imageボタンをクリックします。

2. 3番目の画像である Metal3.jpgをダブルクリックします。

ヒント ブラウザに戻らずに、リファレンスウィンドウからブラウザの中の画像を参照

することができます。処理したい画像を見つけるには、Next Imageボタンと
Previous Imageボタンをクリックします。そして、Make Image Activeボ
タンをクリックし、その画像を処理ウィンドウに移動させることができます。

3. Run Scriptボタンをクリックします。 
図 3-6は、元の画像である Metal3.jpgを示しています。図 3-6bは、
粒子解析処理後の画像です。2つの円形粒子は、互いに接触していた
ため、処理中に画像から取り除かれたことに注意してください。2値
化の手順を調節し、この 2つの粒子を分離させることができます。
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図 3-6 元の画像と処理済みの画像の比較

4. Doneをクリックして、Particle Analysisウィンドウを閉じます。

5. スクリプトウィンドウの Thresholdステップをダブルクリックして、
2値化パラメータを開きます。図 3-7は、スクリプトの Thresholdス
テップでの Metal3.jpgです。

1 重なっている円形粒子

a. b.

1
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図 3-7 粒子解析スクリプトのテスト

6. しきい値を調節し、粒子を確実に分離します。最小値を 150にする
と、最適な結果が得られます。

7. Replaceをクリックします。

8. Run Scriptボタンをクリックし、スクリプトをもう一度実行します。
この時点では、円形粒子のみが最終処理画像に表れることに注意して

ください。

9. Doneをクリックして、粒子解析ウィンドウを閉じます。
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粒子解析スクリプトを保存する
これで、粒子解析アルゴリズムの作成と、別の画像でのテストが終了しま

した。同様の画像でこのスクリプトを使用するため、スクリプトを保存し

ます。また、このスクリプトを使用してバッチ処理を行うこともできま

す。IMAQ Vision Builderでのバッチ処理例は、第 4章「ゲージングを使
用した部品検査」の「バッチ処理で複数の画像を解析する」を参照してく

ださい。

1. Script→ Save Scriptを選択します。

2. スクリプトを blob analysis.scrとして保存します。

処理時間を推定する
IMAQ Vision Builderでは、IMAQ Visionを使用して現在の画像を開い
たスクリプトで処理するのに要する時間（ミリ秒）を推定することができ

ます。パフォーマンスメータは、IMAQ Visionが画像を処理するのに要
する合計時間とスクリプト内の各関数が必要とする時間の両方を予測しま

す。IMAQ Visionが blob analysis.scrで Metal3.jpgを処理するの

に要する時間は何ミリ秒であるかを推定するには、次の手順に従ってくだ

さい。

1. Script→ Performance Meterを選択します。IMAQ Visionがスク
リプトを実行するのに要する合計時間を Performance Meterで推
定します。

2. Detailsをクリックして、IMAQ Visionがスクリプトの各関数を実行
するために要する時間の項目別リストを表示します。

3. OKをクリックして、パフォーマンスメータを閉じます。
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LabVIEW VIを作成する
IMAQ Vision Builderの特徴として、スクリプトの手順を実行するための
LabVIEWおよび IMAQ Visionの VI生成ウィザードがあります。図 3-8
は、VI生成ウィザードを示しています。

図 3-8 LabVIEW VI 生成ウィザード

LabVIEW VIを作成するには、次の手順に従ってください。

1. Script→ Create LabVIEW VIを選択します。

メモ LabVIEWおよび IMAQ Visionの複数のバージョンがシステムにインストール
されている場合、ウィザードはシステムを検索し、VIの作成に使用できる
LabVIEWおよび IMAQ Visionのバージョンのうち、使用可能なもののリスト
を表示します。リストから LabVIEWの該当するバージョンを選択し、Nextを
クリックします。

2. Current Scriptを選択し、プロトタイプしたアルゴリズムを実行する
VIを作成します。

3. Image Sourceおよび Acquisition Typeを選択し、Nextをクリッ
クします。

4. Image File as the Image Sourceを選択し、ハードディスクから画
像を開くための VIを作成します。
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5. 作成した VIのフロントパネルに制御器（入力）および表示器（出力）
として表示したいパラメータにチェックマークを付けます。チェック

マークを付けていないパラメータはすべてダイアグラム内の定数とし

てハードコードされます。

6. VIを作成するには、Finishをクリックします。

メモ IMAQ Vision Builderの LabVIEW VIの作成機能を使用するには、LabVIEW 6
以降および LabVIEW対応 IMAQ Vision 6以降が必要です。
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4
ゲージングを使用した部品検査

この章では、ゲージ測定についての説明と、IMAQ Vision Builderで部品検
査アプリケーションをプロトタイプするための各手順が記載されています。

ゲージ測定とは

コネクタ、スイッチ、リレーなどの部品は小さく、大量に製造されていま

す。人間が検査をしたのでは、仕事が単調なばかりでなく時間を消費しま

す。ビジョンシステムでは、部品の機能の統一性を保ちながら高スピード

で測定することができ、測定結果をレポートとして生成します。その測定

結果から、部品が仕様を満たしているかどうかを判断することができます。

その製品が適格に製造されているかを判断するため、ゲージングは、長

さ、直径、角度、総数などの重要な各種距離測定から構成されています。

ゲージングの距離や総数が許容範囲外の場合、構成部品は仕様を満たさな

いため不合格となります。ゲージング検査は、機械組み立ての検証、電子

部品梱包検査、容器検査、ガラスビン検査、電子コネクタ検査で頻繁に使

用されます。

チュートリアル

このチュートリアルでは、パイプブラケットの画像を解析し、そのブラ

ケットが物理的仕様を満たしているかどうかを確かめます。パイプブラ

ケットとは、束ねたワイヤのチューブなど、細長い部品をボルトで留める

ために使用する金属片です。

ブラケット間の角度および距離を測定し、こうした測定値が許容範囲内と

なるようにアプリケーションを作成します。図 4-1は、測定場所と測定の
許容値を示しています。
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図 4-1 ブラケットの仕様

幅の中心は、ブラケット幅の中心です。幅の中心は、ブラケット角の頂点

になります。ブラケットの角度は、ブラケットのアームの角度を測定し、

ブラケットの両アームのアラインメントが適切かどうかを判断します。ブ

ラケットの距離では、ブラケットの 2つの穴間の距離（ピクセル）を測
定します。また、ブラケットの距離では、ブラケットのアーチが適切な高

さでカーブしているかどうかも判断します。

この解析を実行する際、IMAQ Vision Builderは処理操作およびスクリプ
トのパラメータをすべて記録します。どれが良品でどれが欠陥品かを判断

するには、別のブラケット画像でスクリプトを実行します。
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画像を IMAQ Vision Builderにロードする
画像をロードするには、次の手順に従ってください。

1. IMAQ Vision Builderをスタートメニュー（スタート→プログラム→
National Instruments IMAQ Vision Builder 6）から起動します。

2. File→Open Imageを選択して、画像をロードします。

3. Program Files\National Instruments\IMAQ Vision Builder 

6\Examples\Bracketを開き、Select All Filesオプションにチェッ
クマークを付けます。IMAQ Vision Builderでは、画像プレビュー
ウィンドウで画像をプレビューし、ファイルのフォーマットサイズと

種類を表示します。

ヒント 画像プレビューウィンドウには、選択した画像がすべて順に表示されます。画

像を表示する速さを変更するには、画像プレビューウィンドウの右にある速度

スライドを調節します。

4. OKをクリックし、画像ファイルを IMAQ Vision Builderにロードし
ます。画像ブラウザ内に収集した画像の中から、処理する画像を選択

することができます。 

5. 最初の画像である Bracket1.jpgをダブルクリックして、それを処

理ウィンドウにロードします。

パターンマッチングを使用して測定点を見つける
測定を行う前に、ベースにする特徴を見つけることが必要です。この例で

は、ブラケットにあけられた穴をパターンマッチングで見つけることがで

きます。こうした穴は、ブラケットのアーチが適切な高さおよびカーブで

あるかどうかを判断するための測定点として役立ちます。

1. Machine Vision→ Pattern Matchingを選択します。Learn 
Templateタブが選択されていることを確認してください。

2. 図 4-2のように、Rectangle Toolで画像左の穴の周りにボックスを
クリックおよびドラッグして描きます。選択した範囲または関心領域

（ROI）がテンプレートパターンになります。

図 4-2 テンプレートパターンの選択
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3. Create from ROIをクリックし、選択した範囲をテンプレートパ
ターンとして記憶します。テンプレートを記憶するには、数秒かかり

ます。IMAQ Vision Builderがテンプレートを記憶した後、保存ダイ
アログボックスが表示されます。

4. Program Files\National Instruments\IMAQ Vision Builder 

6\Examples\Bracketを開きます。

5. テンプレートを template.pngとして保存してください。パターン

マッチングパラメータウィンドウには、テンプレートの画像とそのパ

スが表示されます。

6. Search Templateタブを選択します。

7. Search Modeを Shift Invariantとして設定します。検索しようと
している部分が画像内で回転しないと予測される場合は、横ずれに影

響されないマッチング（Shift Invariant）を使用します。回転する可
能性がある場合は、回転に影響されないマッチング（Rotation 
Invariant）を使用します。 

8. Sub-Pixel Accuracyチェックボックスをチェックします。

9. Minimum Scoreを 600に設定します。Minimum Scoreを 600に
すると、IMAQ Vision Builderはテンプレートと厳密には一致してい
ないが似ている部分を見つけます。

10. Number of Matchesを 1に設定します。

11. 図 4-3のように、ブラケットの左側に Rectangle Toolで ROIを描
きます。描く領域は必ず、テンプレートの画像よりも大きく、また解

析する他の画像内のテンプレート位置をすべて含むのに十分な大きさ

になるようにしてください。

テンプレートの一致を検出するための関心領域を描くのは、パターン

マッチングでは非常に大切な工程です。これにより、不一致を検出す

る可能性が減少します。また、画像内での複数のテンプレート例を検

出する際、順番を指定することもできます。

図 4-3 最初の検索範囲の選択

一度関心領域を描くと、IMAQ Vision Builderは自動的にテンプレー
トをその領域に見つけ、一致度と位置を表示します。一致度は 1000
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であることに注意してください。画像の同範囲からテンプレートを作

成したため、このテンプレートは、完全に一致しています。

12. Applyをクリックして、この工程をスクリプトに追加します。

13. 図 4-4のように、関心領域をブラケットの右側に Rectangle Toolで
描きます。IMAQ Vision Builderは、テンプレートを長方形で囲まれ
た領域内に自動検出し、一致度と位置を表示します。

図 4-4 2番目の検索範囲の選択

2番目の一致度は完全な 1000ではありませんが、テンプレートに一
致しているとみなすのに十分高いスコアです。

14. Applyをクリックして、この工程をスクリプトに追加します。

15. Closeをクリックします。

画像内のエッジを検出する
ブラケットが仕様を満たすかどうかを判断するための測定値を計算するに

は、まずその測定値の基になるエッジを検出することが必要です。Edge 
Detector関数により、ツールパレットの Line Toolで引いたライン上に
あるエッジを検出します。

1. Machine Vision→ Edge Detectorを選択します。

2. Advanced Edge Toolを選択します。Advanced Edge Toolは、
背景とオブジェクトのコントラストが低い画像に効果的です。

3. First & Last Edgeを選択します。IMAQ Vision Builderは、引いたラ
インに合う最初と最後のエッジのみを検索して名前をつけます。

4. Contrastを 40に設定します。この検出プロセスは、最初と最後の
エッジでコントラストが 40を超えるエッジのみを返します。

5. 図 4-5のように、幅の中心を測定するために使用できるエッジを検出
するには、クリックしドラッグして、ブラケットの真中を通る縦のラ

インを引きます。IMAQ Vision Builderは、そのエッジに 1、2と名
前を付けます。
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ヒント 直線を引くには、<シフト >キーを押しながら線を引きます。

図 4-5 ブラケットの距離を測定するためのエッジを検出

ラインプロファイルを参照してください。ラインプロファイルの急激

な変化はエッジとして表示されます。エッジの数は、ラインプロファ

イルの下に表示されることに注意してください。

6. Applyをクリックして、このエッジ検出の工程をスクリプトに追加
します。

7. Closeをクリックして、エッジ検出ウィンドウを閉じます。

測定を行う
ブラケットの穴と必要なエッジが検出されましたので、ブラケットの幅、

ブラケットの穴間の距離、ブラケットアームの角度を Caliper関数で計
算することができます。Caliper関数は、距離、角度、セグメントの中
心、あるいは面積などの測定を行う時の画像上の点（点の数は、画像上で

選択した点の数による）を使用したツールです。そのような点は、エッジ

検出やパターンマッチングなど、上記の処理工程を実行することで得られ

ます。

測定を行うには、次の手順に従ってください。

1. Machine Vision→ Caliperを選択します。

2. 画像内の 3および 4の点をクリックし、ブラケット幅の中心を指定
する最初の測定値（幅の中心）を取ります。

ヒント 点がなかなか見つからない場合は、ツールパレットの Zoom Inツールをクリッ
クして画像を拡大します。倍率は、操作ウィンドウの左下端に表示されます。

1/1だと、倍率は 100%に指定されます（デフォルト）。また、2/1ではやや拡
大された表示に、1/2ではやや縮小された表示になります。

1

2
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ヒント 画像内の点をクリックする代わりに、Pointsリストボックスの点をダブルク
リックして選択することもできます。点を選択すると、IMAQ Vision Builderは
点の隣にチェックマークを付けます。

3. Type of Measureリストから Centerを選択します。

4. Measureボタンをクリックしてブラケットの幅の中心を計算し、
図 4-6のように、幅の中心測定を結果表に追加します。

図 4-6 Caliper関数で幅の中心を検出する

5. Applyをクリックし、この工程をスクリプトに追加します。

6. Machine Vision→ Caliperを再び選択します。ブラケット幅の中
心が 5として表示されます。

7. 画像の 1、2の点をクリックして、2つ目の測定値を求めます（ブラ
ケット幅）。これは、ブラケット内に造られた穴と穴の間の長さを測

定し、ブラケットのアーチの高さが適切であるかどうかを判断しま

す。

8. Distanceを Type of Measureリストから選択します。

3

4

1 2
–
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9. Measureボタンをクリックし、ブラケットの穴と穴の間の距離を計
算し、測定値を測定結果表に追加します。

10. 1、5、2の各点をこの順番でクリックし、3つ目の測定値を求めます
（ブラケットの角度）。これは、図 4-7のように、5の点を頂点として
ブラケットアームの角度を測定します。

11. Type of Measureリストから Angleを選択します。

12. Measureボタンをクリックしてブラケットアーム間の角度を計算
し、測定値を測定結果表に追加します。

図 4-7は、ブラケットの距離およびブラケットの角度を選択した状態の画
像とその測定結果を表示した表を示します。

図 4-7 キャリパツールを使用した測定値の収集

13. Applyをクリックして、キャリパ測定値をスクリプトに追加し、
キャリパウィンドウを閉じます。

14. Script→ Save Script選択し、スクリプトを bracket.scrとして保

存します。

3

4

1 25
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バッチ処理で複数の画像を解析する
スクリプトを使用して複数のブラケット画像をバッチ処理し、すべての測

定データを含むテキストファイルを生成するには、次の手順に従ってくだ

さい。

1. Script→ Batch Processingを選択します。

2. Image Sourceから Browserを選択し、ブラウザに保管されている
画像を処理します。

リストボックスには、スクリプト内の工程がすべて含まれています。

スクリプト内の工程はどれでも選択することができ、また、工程を行

うことで得た測定結果をファイルに保存、表示したり、パラメータ

ウィンドウを開いて各繰り返しの設定を調節するなどのオプションを

選んだりすることができます。上記の例では、キャリパパラメータ

ウィンドウを開き、キャリパで測定した結果をファイルに保存します。

3. リストボックスの最後の Caliperステップを選択します。

4. Analysis ModeのOpen Results Panelと Save Resultsをチェッ
クします。

5. Setupボタンをクリックして以下のオプションを設定します。

a. One file for all resultsを選択します。

b. Browseボタンを押し、そのファイルの保存先のディレクトリを
開き、選択をクリックします。

c. File Name Prefixボックスに bracket.txtとタイプし、測定結

果ファイルに統一した名前を付けます。

6. OKをクリックして、設定オプションを閉じます。

7. Run!をクリックして、バッチ処理を開始します。
バッチ処理を実行する際、進行状況表示ウィンドウが IMAQ Vision 
Builderウィンドウの左側に表れます。進行状況表示ウィンドウに
は、現在のプロセス（画像の集録または処理）、そのプロセスが完了

した回数、開始時間、および推定残り時間が表示されます。バッチ処

理を停止する必要がある場合は、Cancelボタンをクリックします。

メモ バッチ処理パラメータを設定する際にOpen Results Panelをチェックしたた
め、スクリプトが各画像に対して実行された後、Doneボタンをクリックする
ことが必要です。

8. バッチ処理が完了したら、OKをクリックします。

9. Returnをクリックして、バッチ処理ウィンドウを終了します。

ブラケット画像が処理され、キャリパで測定した結果がテキストファイル

に保管されました。
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結果を解析する
このアルゴリズムを LabVIEW VI生成の機能や Builderファイルを使用
してシステムの開発環境に採用する際、測定結果の解析を忘れずに含める

ようにしてください。例えば、測定結果を素早く解析するために

Microsoft Excelを使用することができます。

メモ チュートリアルのこの部分を完了するには、Microsoft Excel 97以降がシステ
ムにインストールされていることが必要です。

1. Microsoft Excelを起動します。

2. Excelから bracket.txtを開き、測定結果を表示します。

測定結果には名前が付いていて、ブラウザに表示されている画像の順序で

リストに記載されます。この場合、画像は Bracket1.jpgから

Bracket6.jpgの順に表示されます。

表 4-1には、ブラケットの測定の許容範囲とブラケット画像で見る実際の
値がリストされます。Bracket1、Bracket2、Bracket3だけが仕様を満

たしていることに注意してください。他のブラケットの太字の値は、不合

格の原因になった測定値を示しています。

メモ Excelに表示される測定結果は、表 4-1にある値とは厳密には一致しない場合が
あります。ただし、測定結果として得られた値は、表 4-1の値に十分近いはずで
す。したがって、Bracket1、Bracket2、Bracket3は合格、Bracket4、

Bracket5、Bracket6は不合格となります。

表 4-1 ブラケットの測定結果

ブラケット番号

ブラケットの距離

（許容範囲：362～ 368ピクセル）
ブラケットの角度

（許容範囲：178°～ 181°）

ブラケット 1 363.00 179.8

ブラケット 2 364.00 180.3

ブラケット 3 363.00 179.7

ブラケット 4 349.00 178.5

ブラケット 5 339.01 178.4

ブラケット 6 359.03 174.8
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A
技術サポートのリソース

ウェブサポート

インストール、構成、アプリケーションに関わる問題および疑問を解決す

るには、まず弊社ウェブサイトの「サポート」のページをクリックしてく

ださい。 問題を解決・診断するオンラインリソースには、よくある質問に
対する答え、技術サポートデータベース、製品別のトラブルシューティン

グウィザード、マニュアル、ドライバ、ソフトウェアのアップデート等の

情報があります。 ウェブサポートをご利用になるには、ni.com/jpの

「サポート」のページにアクセスしてください。 

NI Developer Zone
ni.com/zone の NI Developer Zoneには、自動計測システムの構築に
不可欠なリソースがあります。 NI Developer Zoneでは、開発者独自の
技術を共有するための開発者コミュニティだけでなく、最新のサンプルプ

ログラム、システムコンフィギュレータ、チュートリアル、および技術

ニュース等に簡単にアクセスできます。

カスタマートレーニング

ナショナルインスツルメンツは、お客様のトレーニングの要望にお応えす

るための様々な方法を提供しております。お客様自身のペースで学習でき

るチュートリアル、ビデオ、対話式 CDや世界各地で開催中のインスト
ラクタによる実践コース等をご用意しております。 コースのスケジュー
ル、摘要、トレーニングセンター、およびクラスへの登録については、

ni.com/jpで「セミナー／イベント」をクリックしてください。

システムインテグレーション

時間的制約がある場合、社内の技術リソースに制限がある場合等は、コン

サルティングまたはシステムインテグレーションサービスをご利用いただ

けます。 弊社のアライアンスプログラムメンバーのネットワークを通じ
て、様々な専門技術や知識を得ることができます。 アライアンスプログラ
ムのシステムインテグレーションソリューションの詳細については、

ni.com/jpの「ソリューション」を参照してください。
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世界各地でのサポート

ナショナルインスツルメンツは、お客様のサポートの要望にお応えするた

め世界各地に支社を配置しております。 ni.comのWorldwide Offices
から各支社のウェブサイトにアクセスできます。これらのウェブサイトで

は、最新の連絡先、サポートの電話番号、Eメールアドレス、および現在
のイベントについての情報を提供しています。 

弊社ウェブサイトの技術サポートリソースを検索しても必要な情報が得ら

れない場合は、最寄の営業所またはナショナルインスツルメンツ本社にお

問い合わせください。 世界各国の支社の電話番号については、本書の最初
のページをご覧ください。
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用語集

接頭辞 意味 値

p- ピコ 10-12

n- ナノ 10 -9

µ- マイクロ 10- 6

m- ミリ 10 -3

k- キロ 103

M- メガ 106

G- ギガ 109

t- テラ 1012

数／記号

2値化 指定範囲内の輝度のピクセルをすべてオブジェクトに、それ以外のピクセ

ルを背景に割り当てることにより、オブジェクトを背景から分離します。

上記の結果得られるバイナリ画像でのピクセルの輝度は、オブジェクトは

255で表され、背景は 0に設定されます。

3D 3次元。

3D表示 3次元座標系の画像の輝度を表示します。3次元座標系では、画像の空間
座標が 2次元を形成し、輝度が 3つ目の次元を形成します。

B
b ビット。2進数の 1桁で、0または 1。

B バイト。データの 8つの関連ビット。8ビットの 2進数。また、1バイト
のデータを保管するにの必要なメモリ量。

BMP ビットマップ。8ビットおよびカラー画像（拡張子：BMP）で一般的に
使用される画像ファイル形式。
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H
HSI 色相、彩度、輝度によるカラーエンコードテクニック。

HSL ピクセルの各画像が 32ビットでエンコードされる色相、彩度、輝度情報
を使用した、カラーエンコードテクニック。色相に 8ビット、彩度に 8
ビット、輝度に 8ビットを使用します。残りの 8ビットは使用しません。

HSV 色相、彩度、明度によるカラーエンコードテクニック。

I
I/O 入力／出力。通信チャネルや演算子インタフェースデバイス、データ集録や

制御インタフェースを使用したコンピュータシステムとの間のデータ転送。

IMAQ 画像集録。

J
JPEG Joint Photographic Experts Groupの略。高減衰圧縮で 8ビットカラー

画像を保管する画像ファイル形式（拡張子：JPG）。

L
LabVIEW Laboratory Virtual Instrument Engineering Workbenchの略。プログ

ラム開発環境アプリケーション。テストや計測アプリケーションで一般に

使用するプログラミング言語Gを基本とします。

M
M （1）メガ。ボルト、ヘルツ等の測定単位とともに使う場合、メートル法

の 100万の標準接頭辞。または 106。（2）メガ。データやメモリを量子
化するためにバイトとともに使う場合、1048576の接頭辞または 220。

MB メガバイトのメモリ。

MMX マルチメディアの拡張機能。整数に対する並行操作が可能なため、8ビッ
ト画像の加速処理を実現するインテルのクリップベース技術。
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N
NI-IMAQ ナショナルインスツルメンツの画像集録ハードウェア用ドライバソフト

ウェア。

P
PNG ポータブルネットワークグラフィック。非高減衰圧縮で 8ビット

画像、16ビット画像、カラー画像を保管する画像ファイル形式
（拡張子：PNG）。

pts 点。

R
RGB 赤、緑、青（RGB）の色情報を使用したカラーエンコードテクニックで、

カラー画像の各ピクセルが赤に 8ビット、緑に 8ビット、青に 8ビット、
アルファ値（通常は不使用）に 8ビットの計 32ビットでエンコードされ
ます。

ROI 関心領域。（1）画像を表示しているウィンドウからグラフィカルに選択さ
れた画像の領域。この領域に焦点を当ててその後の処理を行うことができ

ます。（2）集録ウィンドウでハードウェアプログラム可能な四角形の部分。

ROIツール LabVIEWのツールパレットにあるツールの集まりで、これにより画像か
ら関心領域を選択することができます。これらのツールにより、点や線、

多角形、四角形、楕円形の範囲を選択したり、フリーハンドによる線や範

囲も選択したりすることができます。

T
TIFF Tagged Image File Formatの略。8ビット、16ビット、カラー画像を

エンコードするのに一般的に使用される画像形式（拡張子：TIF）。

V
VI 仮想計測器。（1）従来のスタンドアロン計測器と同じ機能を持つ、ハー

ドウェアおよびソフトウェア要素の組み合わせで、通常 PCとともに使用
します。（2）フロントパネルユーザインタフェースとブロックダイアグ
ラムのプログラムで構成される LabVIEWのソフトウェアモジュール
（VI）。



用語集

IMAQ Vision Builderチュートリアル 用語集 -4 ni.com/jp

あ

明るさ 「ルマ」を参照。

穴埋め関数 バイナリ画像に存在するオブジェクトの穴を埋めます。

い

一致度 集録した画像がテンプレートの画像にどのくらい一致するかを示す 0～
1000の数値。一致度の 1000は、完全に一致していることを示します。
一致度の 0は、全く一致していないことを示します。

イメージング 画像を集録および表示する工程。また、画像データを解析する工程。

え

エッジ 画像内であるいはピクセル配列内でのピクセル輝度の急激な変化（遷移）

により定義されます。

エッジ輝度差 エッジの傾きや遷移領域に対応するピクセル数。

エッジ検出 画像内のオブジェクトのエッジを認識するテクニックのうちの一つ。

エッジコントラスト エッジの前と後のピクセル輝度の平均値の差。

円形関数 バイナリ画像の円形オブジェクトを検出します。

演算子 画像のマスキング、組み合わせ、および比較をすることができます。

IMAQ Visionでは、算術演算子および論理演算子を使用できます。

お

オープン 収縮の後に膨張を行うこと。オープンは、小さいオブジェクトを取り除

き、画像におけるオブジェクトの境界を平滑化します。

か

カーネル ピクセルとその近隣のピクセルとの関係を表す構造。関係は、各近接ピク

セルの重心係数によって指定されます。

解像度 ピクセルの行と列の数。m行と n列で構成される画像の解像度は、
m× nです。
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回転に影響されないマッ

チング

パターンマッチングテクニック。基準パターンは、テスト画像内のどのよ

うな向きでも検出することができ、またどのような角度でも回転すること

ができます。

画素 デジタル画像の要素。ピクセルとも言います。

画像 xと yが空間座標を形成し、点（x、y）の f値はすべてその点の輝度に比
例する、2次元輝度関数 f（x、y）。

画像強調 S/N比、画像コントラスト、エッジ鮮明度等について、センサから集録す
る画像の質を向上する工程。

画像形式 画像をファイルにどのように保管するかを定義します。通常、ヘッダとそ

のあとのピクセルデータで構成されます。

画像処理 画像に適用できるさまざまな処理関数および解析関数を含みます。

画像鮮明度 「ピクセル深度」を参照。

画像の視覚化 ユーザへの画像（画像データ）の提示（表示）。

画像のボーダー ユーザが定義する、画像を囲んだピクセルの領域。近接ピクセルの値に基

づいてピクセルを処理する関数は、画像のボーダーが必要です。

画像パレット 画像を画面に表示するのに使用される色のグラデーション。通常、カラー

ルックアップテーブルで定義されます。

画像ファイル ピクセルデータと画像に関するその他の情報を含むファイル。

画像ブラウザ ビジョンアプリケーションで解析や処理をするための小さい表示の画像を

含む画像。

カラー画像 カラー情報を含む画像は、通常 RGB形式でエンコードされます。

関数 入力パラメータと出力パラメータのいずれかまたは両方があり、実行する

と値を返すソフトウェアのコマンド。

き

基準パターン マシンビジョンのアプリケーション等が画像内の部品の位置や向きを検出

する時に役立つ基準パターン。

輝度 （1）カラーデコード処理において、カラーピクセルの赤、緑、青の成分
に加えられる定数。（2）白いオブジェクトとグレーを、また明るいオブ
ジェクトと暗いオブジェクトを見分ける知覚。（3）赤、緑、青の 3原色
の合計を 3で割ったもの。（赤 +緑 +青）／ 3。
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輝度 2値化 オブジェクトのグレーレベル値の範囲に基いてそのオブジェクトを特徴付

けます。オブジェクトの輝度範囲がユーザ指定の範囲内の場合は、それを

オブジェクトとみなします。そうでない場合は、背景の一部とみなします。

輝度範囲 画像のオブジェクトのグレーレベル値を決定します。

輝度プロファイル 画像の ROI上におけるピクセルのグレーレベル分布。

キャリパ （1）エッジ検出、粒子解析、図心、検索関数により得られる位置に基づ
いて、距離や角度、円形フィット、重心等を計算する IMAQ Vision 
Builderの関数。（2）画像内の指定したラインに沿って 2つのエッジを検
出する測定関数。この関数は、エッジ抽出を行い、次に前のエッジと後の

エッジとの間の距離、エッジのコントラストなどの指定した基準に基づい

て、2つのエッジを探します。

近接演算 その点に近接するピクセルの値を考慮に入れた、画像の点に対する演算。

近接ピクセル 画像を処理する際、その値が近接するピクセルの値に影響を及ぼすピクセ

ル。通常、近接ピクセルは、カーネルまたはそれを構造化している要素に

より定義されます。

く

クローズ 膨張の後に収縮を行うこと。クローズは、オブジェクトの小さい穴を埋

め、オブジェクトの境界を平滑化します。

クロマ ビデオ信号におけるカラー情報。

クロミナンス 「クロマ」を参照。

け

ゲージング オブジェクトまたはオブジェクト間の距離を測定すること。

計測器ドライバ 特定のプラグインシステムボードを制御する NI-IMAQ等の上位ソフト
ウェア関数のセット。計測器ドライバは、プログラミング言語から呼び出

し可能な関数から LabVIEWの仮想計測器（VI）に至るまで、さまざまな
形式で使用可能です。

検査 部品自体の欠損や部品表面のひび割れ等、小さな欠陥をテストするための

工程。
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検査関数 画像内のピクセル群を解析し、サイズ、形、位置、およびピクセルの連結

性に関する情報を返します。典型的なアプリケーションには、部品の品質

検査、欠陥解析、オブジェクト検索、オブジェクト分類があります。

こ

コントラスト カラーデコーディングプロセスで、カラーピクセルの輝度およびクロマに

適用する定倍数。

コンボルーションカーネ

ル

フィルタ処理において、フィルタを表すのに使用する 2Dマトリクス（ま
たはテンプレート）。カーネルには、対応するフィルタのインパルス応答

の不連続的な 2次元表記が含まれています。

さ

最適オープン 小さい粒子を取り除いたりオブジェクトの境界を平滑化するために使用で

きる、オープン演算、クローズ演算の連続した有限的組み合わせ。

最適クローズ 小さい穴を埋めたりオブジェクトの境界を平滑化するために使用できる、

クローズ演算、オープン演算の連続した有限的な組み合わせ。

彩度 純色に加えられた白色の量。彩度は、色の鮮かさによって決定されます。

彩度の「ゼロ」は、白をまったく加えない純色に相当します。ピンク色

は、赤の彩度を下げた色です。

サブピクセル解析 ピクセルの一部について、エッジ座標の位置を見つけます。

算術演算子 画像の諸演算。掛け算（multiply）、割り算（divide）、足し算（add）、
引き算（subtract）、余り（remainder）。

し

しきい値 2つのパラメータ、つまり、低い方の 2値化グレーレベル値と高い方の 2
値化グレーレベル値。

色相 ピクセルの主要な色。色相関数は、R、G、Bの 3原色を使用して生成で
きるすべての色に対応する連続関数です。「RGB」も参照。

シフトに影響されない

マッチング

パターンマッチングテクニックの一つで、基準パターンはテスト画像内の

どこにあっても検出できますが、向きやサイズが違うとマッチングできま

せん。
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収縮 オブジェクトの境界に沿ってオブジェクトのサイズを小さくし、画像内の

離れた点を取り除きます。

す

数量解析 画像内のオブジェクトのさまざまな測定値を得ることができます。

スケールに影響されない

マッチング

パターンマッチングテクニックの一つで、基準パターンはテスト画像での

大きさに影響されません。

スムージングフィルタ 近接ピクセルの輝度の差を減衰することによって画像をぼかします。

せ

鮮明度 ピクセルがとる値の数。つまり、画像内に見られるカラーやグレーのグ

レースケールの数。

つ

ツ－ルパレット 関心領域の選択、拡大と縮小、および画像パレットの変更ができるツール

の集まり。

て

デジタル画像 不連続のピクセル数に変換された画像 f（x、y）。空間座標と輝度の両方
が指定されます。

デフォルト設定 ドライバに記録されたデフォルトパラメータ値。多くの場合、制御器のデ

フォルト入力は特定の値になっています（たいていは 0）。

テンプレート カラーマッチング関数、形状マッチング関数、パターンマッチング関数を

使用して、画像上で一致させようとしている色、形、またはパターン。テ

ンプレートは、画像上で選択した領域の場合もあれば、画像全体を指す場

合もあります。

と

ドライバ IMAQや DAQデバイスなどの特定のハードウェア機器を制御するソフト
ウェア。
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の

濃淡画像 モノクロ情報による画像。

濃淡モフォロジー処理 濃淡画像に対してモフォロジー処理を行う関数。

は

バイナリ 2値化 画像のピクセル輝度に基づいて、画像を処理するオブジェクト（ピクセル

の値は 1に指定）と背景（ピクセルの値は 0に指定）に分離すること。

バイナリ画像 オブジェクトのピクセルの輝度が通常 1（または 255）で、背景のピクセ
ルの輝度が 0の画像。

バイナリモフォロジー

処理

バイナリ画像に対して形態変形操作を行う関数。

パターンマッチング グレースケール画像内にあるグレースケールテンプレートを素早く見つけ

るためのテクニック。

パレット 画像を画面に表示するのに使用される色のグラデーション。通常、カラー

ルックアップテーブルで定義されます。

範囲 ソフトウェアにより制御、定義される集録ウィンドウまたはフレームの四

角形の部分。

範囲 2値化 ユーザ指定の範囲内で、オブジェクトをその大きさに基づいて検出します。

ひ

ピクセル 「画素」と同義。ビデオスキャンラインを構成する最小の要素。コン

ピュータのモニタで表示する際、ピクセルの最適寸法は正方形（アスペク

ト比は 1対 1、また幅は高さに等しい）です。

ピクセル深度 ピクセルのグレーレベルを表す時のビット数。

ピクセルのアスペクト比 ピクセルが占める領域の物理的な縦横サイズの比。集録ピクセルは正方形

であることが最適であるため、最適値は 1.0ですが、カメラの質により通
常 0.95～ 1.05の範囲となります。

ヒストグラム グレーレベル値に対する画像のピクセルの数量的分布を示します。
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ビット深度 ピクセルの値をエンコードするのに使用するビット数（n）。与えられた
nに対し、ピクセルは 2n個の異なる値をとることができます。例えば、

nが 8ビットなら、ピクセルは 0から 255までの 256個の異なる値をと
ることができます。また、nが 16ビットなら、ピクセルは 0から
65,535、または -32,768から 32,767の 65,536個の異なる値をとること
ができます。

ふ

ぶれ／ぼかし 画像が鮮鋭でないこと。一般に、ぶれはカメラの焦点が合っていない場合

に発生します。ローパス周波数フィルタを適用すると、画面を意図的にぼ

かすことができます。

ほ

ボーダー関数 画像の縁に接触しているバイナリ画像のオブジェクト（または粒子）を取

り除きます。

膨張 オブジェクトの境界に沿ってオブジェクトのサイズを大きくし、オブジェ

クトの小さい穴を取り除きます。

ま

マシンビジョン 目視検査のタスクを行う自動アプリケーション。

め

明度 ピクセルの赤、緑、青値の最大値と最小値の平均として計算されたカラー

ピクセルのグレースケール輝度。

も

元の画像 最初の入力画像。

モフォロジー形態変換 画像内のオブジェクトの構造の抽出および変更。オブジェクトの膨張（拡

張）あるいは収縮（縮小）、穴埋め、穴のクローズ、ボーダーのスムージ

ング等をするには、こうした形態変形を使用することができます。これは

主に、オブジェクトの輪郭を描くため、また、量的検査解析の準備のため

に使用します。
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ら

ラインプロファイル 画像のピクセルのラインに沿ったグレーレベル分布を表します。

ラべリング バイナリ画像の各オブジェクトに固有値を割り当てる工程。このプロセス

は、画像内のオブジェクトの数を認識するのと、各オブジェクトを固有に

識別するのに役立ちます。

り

粒子 ピクセルの輝度レベルがすべて同一の画像における、連続したピクセルの

領域または集合。

粒子解析 画像内の粒子に関する情報を生成する解析関数および一連の処理操作。

る

ルマ ビデオ映像の輝度情報。ルマ信号の振幅は、ビデオ信号輝度に比例して変

化し、モノクロ映像と完全に対応します。

ろ

論理演算子 画像の各演算。AND、NAND、OR、XOR、NOR、XNOR、差
（difference）、マスク（mask）、平均（mean）、最大値（max）、最小
値（min）等。
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R
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S
Select All Filesオプション、3-2、4-3
Send Data to Excelボタン、3-10
Show Labelsオプション、3-9

V
Visual Basic、3-10

Z
Zoom Inツール、4-6

う
ウィンドウ
集録、1-3
処理、1-4、2-3
スクリプト、1-3、2-6
パラメータ、1-4
リファレンス、1-4、2-3、3-10

え
エッジ、画像内に検出する、4-5
エッジ検出、1-6
エッジを検出する、4-5
円形エッジ検出、1-6

円形検出、1-6
円形粒子
解析する、3-9
分離する、3-8

円形粒子を解析する、3-9
円形粒子を分離する、3-8
演算子、1-5

お
オンラインヘルプ、1-7

か
カスタマ―トレ―ニング、A-1
画像

IMAQ Vision Builderを開く、2-1
ロードする

画像処理用、2-3
ゲージング用、4-3
粒子解析用、2-3

画像解析関数、1-4
3D表示、1-4
ヒストグラム、1-4
ラインプロファイル、1-4

画像集録、2-7
画像処理

2値化画像、2-5
IMAQ Vision Builder入門、2-1～ 2-7
処理モードを入力する、2-3

画像のフィルタ処理、3-4
画像ブラウザ
最小化表示、2-2
最大化表示、2-2
重要な要素（図）、2-2
ツールバーからアクセスする、3-10
定義、1-3

画像プレビューウィンドウ、4-3
画像ベースキャリブレーション、1-7
画像補正、1-7
画像を一枚スナップする（1回の集録）、2-10
画像を拡大する、4-6
画像をグラブする（連続集録）、2-11
画像を集録する
関心領域、2-11
グラブ（連続画像）、2-11
シーケンス、2-11
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画像補正、1-7
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く
グラブ、2-7
クランプ、1-6
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グレースケール画像処理と解析関数、1-5
図心、1-5
量子化する、1-5

グレースケールモフォロジー処理、1-5

け
ゲージング
エッジを検出する、4-5
概要、4-1
画像をロードする、4-3
測定結果を解析する、4-10
測定を行う、4-6～ 4-8
定義、4-1
はじめに、4-1
パターンマッチングを使用して測定点を

見つける、4-3
バッチ処理、4-9
ブラケットの仕様（図）、4-2

ゲージングのための測定、4-1

さ
最小化表示（画像ブラウザ）、2-2
最大化表示（画像ブラウザ）、2-2

し
シーケンス、2-7
シーケンス集録、2-11
システムインテグレ―ション、A-1
システム要件、1-1
シミュレーションモジュール、2-10、2-11
集録ウィンドウ、1-3
開く、2-8

集録タイプ
グラブ、2-7
シーケンス、2-7
スナップ、2-7

集録モジュール、2-8
処理ウィンドウ、1-4、2-3
目的、2-3

処理モード、2-3
資料

IMAQ Visionのマニュアル、1-8
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